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MENGENAL PERANGKAT  
TEKNOLOGI INFORMASI DAN KOMUNIKASI 

 
Komputer adalah suatu peralatan elektronik yang dapat menerima input (masukan), mengolah input, memberikan 
informasi, menggunakan suatu program yang tersimpan di memori komputer, dapat menyimpan program dan hasil 
pengolahan, serta bekerja secara otomatis. 
 
1.1 Komponen-Komponen Komputer   

Sebenarnya, pengertian komputer lebih tepat jika disebut sebagai sistem komputer. Sistem komputer terdiri dari 3 
perangkat (peranti) / komponen dasar, yaitu : 

a. Perangkat Keras (Hardware) 
b. Perangkat Lunak (Software) 
c. Manusia (Brainware) 
d.  

1. Hardware (Perangkat Keras) 
Merupakan komponen fisik dari sistem komputer yang terdiri dari 3 komponen : 
a. Peranti Masukan (Input Device) 

Adalah peralatan yang digunakan untuk memasukkan data ke komputer.  
Contoh : Keyboard, Mouse, dan Scanner. 

b. Peranti Pengolah (Processing Unit) 
Adalah peralatan yang melakukan pengolahan data menjadi informasi, atau sebagai otak dari sistem 
komputer. Peranti ini sering disebut dengan CPU (Central Processing Unit) atau Processor. CPU memiliki 
dua bagian fungsi operasional, yaitu : 

- ALU (Arithmetical Logical Unit)    Sebagai pusat pengolah data 
- CU (Control Unit)    Sebagai pengontrol kerja komputer 

c. Peranti Keluaran (Output Device) 
Adalah peralatan yang digunakan untuk menampilkan informasi hasil olahan komputer. 
Contoh : Monitor, Printer, dan Speaker.  

Selain 3 komponen utama diatas, sebenarnya ada 1 komponen lagi yang dapat dianggap sebagai komponen 
utama dari Hardware suatu komputer, yaitu : 
d. Penyimpan Cadangan / Backing Storage (Storage Device) 

Adalah peralatan yang berfungsi untuk menyimpan informasi non aktif di dalam komputer.  
Contoh : Harddisk, Floppy Disk, dan Optic Disk {CD-ROM, CD-R, CD-RW, DVD, dll} 

 
Input dan Output devices dapat dikelompokkan dalam satu bagian yang disebut Periferal yang terletak di 

sisi luar casing komputer. Sedangkan CPU dan Backing Storage dikelompokkan sebagai Komputer yang 
biasanya terletak di dalam casing utama komputer.  

 
2. Software (Perangkat Lunak) 

Suatu program yang berisi instruksi/perintah yang ditulis dalam bahasa komputer yang dimengerti oleh 
hardware komputer. Jenis software adalah sebagai berikut : 

- Software Sistem Operasi (Contoh : DOS, Windows 9x, 2000, ME, XP, Linux, dll) 
- Software Aplikasi  (Contoh : Ms. Word, Ms. Excel, Winamp, Adobe, Corel Draw, dll)  

 
3. Brainware (Manusia) 

- User / Operator  Orang yang mengoperasikan komputer 
- Administrator  Orang yang mengatur/merancang sistem kerja komputer dari input data, 

pengolahan data, sampai output data. 
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1.2 Fungsi-Fungsi Dasar Komponen Komputer 
 
A. INPUT 

Adalah perangkat keras komputer yang berfungsi sebagai alat untuk memasukkan data / perintah ke dalam 
komputer. Contoh : Keyboard, Mouse, Scanner, Digital Camera, Microphone. 
 

B. I/O PORTS 
Adalah bagian pada komputer yang digunakan untuk menerima ataupun mengirim data keluar sistem 
komputer. Peralatan input dan output komputer terhubung melalui port ini. 
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C. CPU (Central Processing Unit) 

CPU merupakan otak sistem komputer, dan memiliki dua bagian fungsi operasional, yaitu : 
- ALU (Arithmetical Logical Unit) : Untuk melaksanakan proses perhitungan matematik, sebagai pusat 
pengolah data, serta melakukan keputusan dari suatu operasi logika sesuai instruksi program. 
- CU (Control Unit)  :  Sebagai pengontrol kerja komputer dan jika terdapat kesalahan akan muncul pesan 
kesalahan (error message). 
 

D. MEMORI 
Memori terbagi menjadi dua bagian, yaitu : 
a.  Memori Internal / Utama 

-  RAM (Random Access Memory) : Berfungsi untuk menyimpan program yang kita olah untuk 
sementara waktu. Contoh :  EDORAM, SDRAM, DDRAM, dan RDRAM. 

-  ROM (Read Only Memory) : Memori yang hanya bisa dibaca dan berguna sebagai penyedia informasi 
pada saat komputer pertama kali dinyalakan. Pada komputer, ROM terdapat pada BIOS (Basic Input 
Output System) yang terdapat pada Motherboard yang berfungsi untuk mensetting peripheral yang ada 
pada sistem. 

b.  Memori Eksternal / Cadangan  
Adalah perangkat keras untuk melakukan operasi penulisan, pembacaan, dan penyimpanan data, di luar 
komponen utama yang telah disebutkan diatas.  
Contoh: Floppy Disk, Harddisk, CD-ROM, dll. 
 

E. OUTPUT 
Adalah perangkat keras komputer yang berfungsi untuk menampilkan keluaran sebagai hasil pengolahan 
data. Keluarannya dapat berupa : 
  -  Hard-copy     Dicetak ke kertas      Contoh Alat : Printer 
  -  Soft-copy     Berupa signal elektronik yang dikeluarkan dalam bentuk : 
             a. Tampilan gambar  Contoh Alat  : Monitor   
             b. Suara       Contoh Alat  : Speaker   

 
1.3 Port-Port Komputer 
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1.4 Perangkat KEYBOARD 

Keyboard berbentuk seperti papan ketik yang secara umum berguna untuk memasukkan data atau perintah ke 
dalam komputer (komponen input devices).   
Sebuah keyboard terbagi dalam 5 bagian (kelompok), yaitu : 
a. Tombol QWERTY  c.  Tombol Edit  e.  Tombol Numerik 
b. Tombol Fungsi    d.  Tombol Kontrol  

Tombol-tombol penting pada Keyboard :  
 Huruf, angka, dan simbol =  Untuk memasukkan huruf, angka, dan simbol pada komputer 
 Enter = Untuk mengakhiri pengetikan; Untuk melaksanakan / mengaktifkan 

perintah / program; dan untuk pindah ke baris berikutnya 
 Tab  = Untuk memindahkan kursor ke tanda tab stop 
 Capslock = Agar huruf yang dimasukkan menjadi huruf besar/huruf kecil semua 

secara permanen 
 Anak Panah = Untuk menggerakkan kursor sesuai keinginan 
 Esc (Escape) = Untuk membatalkan perintah  
 Backspace = Untuk menghapus karakter di sebelah kiri kursor 
 Del / Delete  = Untuk menghapus karakter pada posisi kursor berada 
 Insert  = Untuk menyisipkan karakter 
 Home = Untuk mengembalikan kursor ke awal baris 
 End = Untuk meletakkan kursor ke akhir baris 
 Page Up / Page Down = Untuk menggulung layar tampilan naik / turun 
 Shift ; Ctrl ; dan Alt = Digunakan bersama-sama tombol lain untuk menghasilkan fungsi / 

perintah tertentu 
 Function Keys (F1, F2,…,F12) =   Tombol-tombol yang memiliki fungsi tertentu sesuai dengan 

software / program yang sedang berjalan 
 
1.5   Perangkat PRINTER 

Printer digunakan untuk mencetak data/informasi ke kertas. Merupakan jenis output periferal. Terdapat 3 jenis 
printer, yaitu : 
a. Printer Dot-Matrix  b.  Printer Ink-Jet  c.  Printer Laser-Jet  
 
a. Printer Dot-Matrix  

Printer ini disebut juga impact printer, merupakan jenis printer yang membentuk tanda pada kertas dengan 
mekanisme menyentuh kertas atau menekan pita bertinta pada kertas. 

b. Printer Ink-Jet 
Adalah printer non-ketuk yang menyemprotkan tetesan tinta kecil pada kertas. Printer ini sangat umum 
digunakan, memiliki kualitas cetak cukup bagus dan harga relatif murah.  

c. Printer Laser-Jet 
Merupakan jenis printer elektrografis yang teknologinya berdasarkan / mirip dengan mesin fotokopi dengan 
drum putar (charged rotating drum) yang memiliki sistem lensa, cermin dan laser yang cukup canggih. 
Printer laser merupakan realitas terbaik bagi mereka yang menginginkan hasil cetakan yang mulus, banyak, 
dan mengandung sejumlah nuansa artistik yang menarik. 
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1.6 Identifikasi Perangkat Lunak (Software) dalam Teknologi Komputer 
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ETIKA DAN MORAL  
DALAM MENGGUNAKAN PERANGKAT TIK (KOMPUTER) 

 
Dalam menggunakan perangkat TIK (komputer) kita harus memiliki sikap (etika dan moral) positif, karena 

terdapat program/perangkat lunak yang ada pada komputer yang merupakan hasil karya cipta orang lain 
(perseorangan/kelompok) yang dilindungi oleh Undang-Undang. Oleh karena itu, sebagai wujud penghargaan kita 
atas hasil jerih payah mereka tersebut maka kita sebaiknya tidak ikut serta dalam tindakan membajak, menyalin, 
mengcopy, maupun menggandakan perangkat lunak tersebut tanpa izin dari si pembuat atau tidak sesuai ketentuan 
berlaku. 

Untuk melindungi hasil karya cipta seseorang seperti  karya cipta perangkat lunak (software), maka 
Pemerintah Republik Indonesia mengeluarkan peraturan dalam bentuk Undang-Undang Hak Cipta, yaitu : 

- Undang-Undang Hak Cipta No.7 Tahun 1987 
- Undang-Undang Hak Cipta No.12 Tahun 1997 
- Undang-Undang Hak Cipta No.19 Tahun 2002 

Menurut undang-undang tersebut, Pemegang Hak Cipta atas karya sinematografi dan komputer memiliki hak untuk 
memberikan izin atau melarang orang lain untuk menggunakan ciptaannya untuk kepentingan yang bersifat 
komersil.  
 Pelanggaran terhadap UU Hak Cipta untuk program komputer akan dikenai sanksi atau hukuman yang 
sudah ditetapkan dalam Pasal 72 ayat (3) UU Hak Cipta No. 19 Tahun 2002 yang berbunyi : 

Barangsiapa dengan sengaja dan tanpa hak memperbanyak penggunaan untuk kepentingan komersial suatu 
Program Komputer dipidana dengan pidana penjara paling lama 5 (lima) tahun atau denda paling banyak Rp. 
500.000.000,00 (lima ratus juta rupiah).   

 
Etika dalam penggunaan komputer, khususnya lingkungan fisik tempat pengguna komputer melakukan 

aktifitas mempunyai pengaruh yang kuat dalam menggunakan komputer. 
  

5 (lima) aspek penting untuk menciptakan lingkungan kerja yang nyaman, yaitu : 
1. Pencahayaan 

Tujuan utama dari perancangan pencahayaan adalah : 
1. Menghindarkan pengguna dari cahaya terang 
2. Menghindari cahaya langsung / cahaya pantulan yang langsung mengenai layar tampilan 
3. Memperoleh keseimbangan antara kecerahan layar tampilan dan kecerahan yang ada di depan pengguna 
Faktor-faktor yang perlu diperhatikan dalam pencahayaan : 
1. Pengaturan tempat sumber cahaya untuk meminimalkan pantulan cahaya pada layar tampilan 
2. Penggunaan penutup jendela untuk mengendalikan banyaknya cahaya matahari yang masuk ke ruang 

kerja, sehingga dapat meminimalkan kilauan pada layar 
3. Pengaturan tempat layar tampilan, sehingga kilauan dari sumber cahaya di atas kepala dapat dihindari. 
4. Menghindari sumber cahaya yang terlalu terang yang masuk dalam bidang pandangan mata 
5. Gunakan cahaya tak langsung untuk menghindari bintik cerah pada layar tampilan 

2. Suhu dan Kualitas Udara 
Penggunaan pengontrol suhu, udara diperlukan karena suhu dan kelembaban merupakan faktor penting, 
karena bertambahnya suhu dalam ruang kerja dapat mempengaruhi kinerja seseorang, seperti rasa kantuk, 
konsentrasi berkurang. Persoalan mengenai suhu dan kualitas udara dapat diatasi dari sumbernya. Peralatan 
yang digunakan dapat menyebabkan / meningkatkan suhu panas. Penempatan alat pengontrol udara jangan 
langsung mengenai pengguna yang justru dapat mengganggu konsentrasi. 

3. Gangguan Suara 
Perubahan keras pada suara di lingkungan kerja dapat menimbulkan stress. Hal ini dapat dihindari apabila 
suara tetap dan tidak berlebihan. Manusia dapat mendeteksi suara antara 10 Hz – 20 KHz.  Suara pada 
frekuensi 1000 – 4000 Hz  menyebabkan pendengaran lebih sensitif. Selain frekuensi, suara dapat bervariasi 
dalam hal kebisingan  Satuan desibel (dB). Suara percakapan mempunyai kebisingan : 50 – 70 dB. 
Kebisingan > 140 dB dapat menyebabkan kerusakan pada telinga. 

4,5. Kesehatan dan Keamanan Kerja 
Kondisi keamanan dan kenyamanan kerja ketika memakai stasiun kerja dapat mempengaruhi kondisi umum 
kesehatan pengguna (user), begitupula pada komputer. Untuk itu terdapat prosedur dalam menggunakan 
komputer agar tidak berdampak negatif bagi pemakai (brainware) yaitu aturan tentang Kesehatan dan 
Keselamatan Kerja (K3) dalam menggunakan komputer. 

 
 
 
 
 
 

II 
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KESEHATAN DAN KESELAMATAN KERJA (K3) 

DALAM MENGGUNAKAN PERANGKAT KOMPUTER 
 
3.1  Bagian-bagian Komputer yang Dapat Menimbulkan Dampak Negatif bagi Pemakai 

1. Monitor 
Monitor komputer pada umumnya menggunakan tabung gambar (CRT) yang dapat menyebabkan intensitas 
cahaya yang cukup tinggi untuk diterima oleh retina mata manusia. Oleha karena itu, monitor harus memiliki 
filter (penyaring) intensitas cahaya semisal kaca berwarna gelap untuk menyerap sinar (radiasi cahaya) dari 
monitor agar mata tidak rusak.  

2. CPU 
Perakitan komputer yang tidak teliti dapat menyebabkan aliran listrik dari kabel listrik menyentuh casing 
komputer yang terbuat dari besi/logam sehingga dapat menyetrum pemakai. Oleh karena itu, biasanya pada 
casing terdapat kabel listrik yang berfungsi mengalirkan kebocoran aliran listrik tersebut ke bidang lain (ground). 

3. Mouse dan Keyboard 
Bentuk keyboard dan mouse yang tidak ergonomis bagi tangan si pemakai dapat menyebabkan pegal-pegal 
bahkan mampu menimbulkan radang sendi. Oleh karena itu, pemakai komputer harus memilih keyboard dan 
mouse yang sesuai dengan tangannya masing-masing. Selain bentuk, penempatan posisi keyboard dan mouse 
yang tidak tepat dalam menggunakannya juga bisa mengakibatkan radang sendi. 

4. Kabel Komputer 
Pemasangan kabel listrik yang tidak benar selain dapat menimbulkan kebocoran arus listrik juga dapat 
menimbulkan konsleting sehingga menyebabkan kebakaran. Oleh karena itu, kabel listrik harus terpasang 
dengan benar. 

 
3.2  Posisi Menggunakan Perangkat TIK (Komputer) dengan Benar 

1. Pandangan Mata    
Layar monitor harus tepat berada di bawah pandangan mata, dan jangan biarkan pantulan cahaya monitor 
langsung memantul dari layar ke mata. 

2. Posisi Tubuh 
Agar tubuh tidak cepat lelah, sebaiknya posisi duduk dalam kondisi tegak dan nyaman. Siku dan lutut sebaiknya 
membentuk sudut 90

o
. 

3. Letak Pergelangan Tangan, Jari dan Lengan 
Pastikan mouse dan keyboard sama tingginya dengan siku sehingga gerakan lengan dan jari dapat nyaman 
pada saat mengetik atau menggunakan mouse. Letak pergelangan tangan, jemari dan lengan santai, tidak 
melengkung atau tegang. 

 
3.3  Cara Menggunakan Komputer dengan Prosedur yang Benar  

1. Prosedur Sebelum Menghidupkan Komputer 
-  Periksa apakah  tegangan arus listrik rumah sudah sesuai dengan tegangan arus untuk konsumsi pada 

komputer. Ketidakcukupan tegangan arus dapat berakibat fatal terhadap komputer, misalnya konslet, 
terbakar. 

- Perhatikan apakah ada kabel yang terkelupas pada kabel penghubung antara komputer dengan stop kontak 
rumah.  

- Periksa apakah semua sambungan kabel telah terpasang dengan baik (kabel monitor ke CPU, CPU ke 
Printer, CPU ke Stabilizer, Stabilizer ke stop kontak rumah)   

 
2. Prosedur dalam Menghidupkan Komputer 

-  Pastikan semua kabel yang terhubung dengan perangkat komputer ke listrik tersambung dengan benar. 
- Hidupkan stabilizer. 
- Aktifkan monitor dengan menekan tombol power pada monitor. 
- Aktifkan CPU dengan menekan tombol power, tunggu beberapa saat sampai proses booting selesai. 
- Tunggu sampai layar monitor menampilkan sistem operasi yang digunakan. 
 

3. Prosedur dalam Mematikan Komputer 
- Tutup semua program aplikasi yang dijalankan. 
- Klik tombol “Start” yang berada di sebelah kiri bawah layar pada Taskbar . 
- Pilih Shutdown, lalu klik OK pada Windows 95/98/2000/Me atau Turn Off Computer pada Windows XP. 
- Tunggu beberapa saat sampai muncul kalimat “It’s Now Save to Turn Off Your Computer” pada sistem 

operasi Windows 95/98/2000/Me atau “Windows is Shuting Down” pada Windows XP. 
- Setelah itu, matikan Monitor kemudian matikan Stabilizer.  

 
 

III 
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3.4  Perawatan Perangkat Keras 

- Jangan meletakkan komputer pada tempat yang sempit, beratap bocor, lembab, terkena sinar matahari 
secara langsung. 

- Jangan menutup sebagian komputer dengan kain atau penutup kain pada saat komputer dinyalakan agar 
sirkulasi udara panas pada CPU dan monitor tidak terhalang. 

- Jangan melepas atau memasang peralatan seperti kabel power monitor, kabel mouse, kabel keyboard, dan 
lain-lain ke komputer pada saat komputer hidup karena pada saat itu komputer teraliri arus listrik. 

- Bersihkan dengan kain/kuas pada keyboard yang sering digunakan. 
- Gunakan Disk Cleaner untuk mencegah Disk Drive/Floppy Drive mengalami kerusakan yang disebabkan 

karena debu yang masuk. 
- Jangan terlalu sering mematikan dan menghidupkan komputer dalam jangka waktu kurang dari ½ jam 

karena selain mencegah kerusakan komputer juga dapat menghemat tenaga listrik disebabkan karena 
untuk setiap kali menghidupkan komputer dibutuhkan watt yang sangat besar. 

- Pegang disket/CD dengan cara yang benar yaitu bukan dengan memegang bagian yang merupakan record 
area. 

- Simpan disket/CD pada box yang sesuai. 
- Jangan memasukkan disket/CD dengan cara yang salah. 
- Hindarkan disket/CD dari sinar matahari langsung dan medan magnet.  

 

 

 

 

MENJALANKAN SISTEM OPERASI KOMPUTER (WINDOWS XP) 
 
4.1 Pengenalan Sistem Operasi Windows XP 

Sistem operasi / Operating System (OS) adalah perangkat lunak (software) pada komputer yang berfungsi 
untuk mengendalikan sistem komputer tersebut.  
Contoh :    -     Sistem DOS (Disk Operating System) 

- Sistem Windows (95, 98, 2000, XP)    
- Sistem LINUX (Red Hat, Mandrake)     Sistem Operasi yang gratis 

Windows XP merupakan salah satu dari program sistem operasi komputer yang paling banyak digunakan 
untuk perseorangan / kelompok. Sistem operasi Windows XP adalah sistem operasi yang mampu berdiri sendiri, 
berbeda dengan sistem operasi Windows sebelumnya (Windows 95/98) yang masih tergantung dengan sistem 
operasi DOS. 
 
4.2 Menghidupkan, Me-restart, Mematikan, dan Men-Standby Komputer 
 
4.2.a   Menghidupkan Komputer (Memulai Windows XP) 

 Aktifkan Stabilizer (Stavol) 
 Tekan tombol POWER pada CPU dan monitor 
 Komputer akan melakukan booting, kemudian akan muncul logo WINDOWS XP 
 Tunggu beberapa saat hingga muncul tampilan desktop sesuai sistem operasi yang digunakan, yaitu 

Windows XP. 
 
4.2.b Me-restart, Mematikan, dan Me-Standby Komputer (Mengakhiri Windows XP)  

 Klik tombol Start 

 Pilih dan klik tombol Turn Off Computer   

 Akan muncul beberapa pilihan, yaitu : 

a.  Stand by   Berfungsi seperti standby pada TV, 
dimana komputer siap untuk mengolah 
data tetapi monitor dalam keadaan mati. 

b. Turn Off  Berfungsi untuk mematikan komputer 

c.  Restart    Berfungsi untuk mematikan komputer 
untuk sementara dan menghidupkannya 
kembali 

d.  Cancel  Berfungsi untuk membatalkan proses 
 
 

IV 
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Untuk mematikan komputer :  

Pilih tombol Turn Off yang berada di tengah, tunggu beberapa saat sampai muncul kalimat “Windows is shuting 
down” atau layar monitor berubah gelap (mati), maka komputer sudah siap untuk dimatikan. 

 
 

MENGATUR KONFIGURASI / OPERASI DASAR PADA OS KOMPUTER 
 
5.1  Elemen-Elemen Dasar Windows XP 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DESKTOP 

TASKBAR 

ICON / Shortcut 

Tombol 
START 

Title Bar 

Menu Bar 

Toolbar 

Sizing Button 

Address 

Scroll Bar 

File/Data/ 
Dokumen 

Clock  

Tombol “SIZING BUTTON” 

Minimize Maximize 
Close 

Restore 
Icon FOLDER 

Icon RECYCLE BIN Icon MY COMPUTER 

Window Border  

Window 

Corner  

JENDELA KERJA  

Simbol Pointer 
Mouse untuk 
mengubah 

ukuran jendela 

windows 

V 
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KETERANGAN : 
 
  Icon =  Simbol/gambar yang mewakili suatu file, shortcut, folder, atau drive untuk membukanya. 
  Shortcut = Simbol/gambar yang berfungsi sebagai langkah cepat untuk membuka sebuah 

aplikasi/program (ditandai dengan gambar panah pada gambar icon di sebelah kiri 
bawah) 

 Title Bar = Nama jendela/nama judul program aplikasi yang sedang aktif 
 Menu Bar = Barisan perintah-perintah berupa menu 
 Toolbars = Barisan tombol-tombol yang digunakan untuk menjalankan suatu perintah tertentu 

dengan cepat 
 Sizing Button = Tombol ukuran ; tombol yang berfungsi untuk mengatur tampilan jendela dari suatu 

aplikasi/program. Meliputi : 
 a.  Tombol Minimize = Untuk memperkecil jendela hingga membentuk icon aktif pada Taskbar 
 b.  Tombol Maximize = Untuk memperbesar ukuran jendela / menampilkan secara penuh di layar 
 c.  Tombol Restore = Untuk mengembalikan jendela ke ukuran semula 
 d.  Tombol Close = Untuk menutup/mengakhiri program yang sedang aktif 
 Address  = Tempat untuk menampilkan lokasi (folder) dimana file yang aktif/dipilih berada; dan 

untuk mengetikkan nama drive, folder, atau alamat situs yang diinginkan 
 Scroll Bar = Baris penggulung layar, meliputi 2 jenis : 
 a.  Horizontal Scroll Bar = Untuk menggeser layar ke kiri / kanan 
 b.  Vertical Scroll Bar  = Untuk menggeser layar ke atas / bawah 
 Windows Border = Merupakan sisi-sisi batas dari suatu jendela   
 Taskbar = Baris yang terdapat di bagian paling bawah, menampilkan icon/tombol yang mewakili 

aplikasi yang sedang aktif ataupun shortcut. Terdapat tombol Start di sisi paling kiri 
yang berisi menu-menu pilihan, dan di sisi paling kanan berisi informasi seperti tanggal 
dan jam, pengaturan volume, tombol aplikasi aktif, dan lain-lain. 

 
 
 
 
 
 
5.2 PENGATURAN DAN PENGGUNAAN WINDOWS XP 
 
5.2.a Mengubah Ukuran Jendela Kerja dengan Mouse 

 Arahkan pointer mouse pada Window Border / Window Corner Jendela Kerja hingga pointer mouse berupa 
bentuk menjadi tanda panah dua arah. 

 Tekan tombol kiri mouse dan geser (click and drag) ke arah yang diinginkan hingga didapat ukuran jendela 
sesuai harapan. 

 
5.2.b Memindahkan / Menggeser Jendela Kerja dengan Mouse 

 Arahkan pointer mouse pada Title Bar Jendela Kerja 
 Tekan dan tahan tombol kiri mouse, kemudian geser ke arah yang diinginkan. Jendela kerja secara otomatis 

akan ikut tergeser / pindah tempat sesuai arah yang dituju.  
 
5.2.c Mengatur Format Tampilan Area Kerja Windows XP 

Untuk mengaktifkan jendela pengaturan tampilan area kerja Windows XP, lakukan langkah berikut: 
a. Arahkan pointer mouse pada desktop 
b. Klik kanan mouse satu kali 
c. Muncul kotak pilihan seperti gambar disebelah : 
d. Pilih Properties 
e. Maka akan muncul Display Properties yang akan  

digunakan untuk mengatur tampilan area kerja  
Windows XP.  
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Option-option yang terdapat di kotak dialog Display Properties dan dapat dipilih untuk pengaturan tampilan 
Windows XP adalah sebagai berikut : 
 Themes = Digunakan untuk mengubah seluruh tampilan dari Windows XP. Themes adalah 

satu kesatuan visual unik yang terdiri atas warna, huruf, gambar dan suara, dalam 
sebuah aplikasi. 

 Desktop = Digunakan untuk mengatur tampilan desktop (background/latar) dari Windows XP.  
 Screen Saver = Digunakan untuk menampilkan gambar animasi atau mengosongkan layar secara 

otomatis (blank screen) yang berfungsi untuk mencegah rusaknya layar monitor jika 
menampilkan gambar yang sama secara terus-menerus. 

 Appearance = Memiliki fungsi yang hampir sama dengan Themes, tetapi pengguna bisa mengatur 
tampilannya sesuai keinginannya sendiri. 

 Settings = Digunakan untuk mengubah tampilan resolusi dari layar monitor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.2.d Menjalankan / Membuka Program Aplikasi 

Apabila pada desktop terdapat icon/shortcut dari program aplikasi yang ingin dijalankan, maka membuka 
program dapat langsung melalui icon tersebut dengan cara sebagai berikut:  

Gerakkan pointer mouse ke icon/shortcut tersebut, pilih dan kemudian klik kiri mouse dua kali secara cepat 
atau tekan tombol Enter pada keyboard, maka program secara otomatis akan terbuka/aktif. 

 
 
 

THEMES DESKTOP SCREEN SAVER 

APPEARANCE SETTINGS 
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 Cara lain adalah sebagai berikut : 

a.  Klik tombol Start                          yang berada di kiri Taskbar 

b.  Pilih All Programs, kemudian cari dan pilih icon program/aplikasi yang ingin dibuka pada daftar yang ada 
c.  Setelah didapat, klik kiri mouse dua kali, maka program akan dibuka. 
 
Contoh : Membuka Program Microsoft Word 2003     

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Catatan : 
 

All Programs berisi daftar folder, nama, dan gambar icon/shortcut dari program aplikasi yang terinstall atau 
tersedia di dalam komputer. Icon-icon tersebut dapat dikelompokkan dalam satu folder menu sesuai keinginan 
untuk memudahkan pencarian.  Pengaturan atau pengelompokkan sendiri icon-icon/folder pada tampilan All 
Programs dapat dilakukan melalui Windows Explorer, yaitu pada alamat:  
C:\Documents and Settings\All Users\Start Menu\Programs 

 
 
5.2.e Mengatur Tampilan Angka, Mata Uang, Tanggal dan Waktu 
 

 Klik tombol Start                       , kemudian pilih Control Panel 

 Muncul daftar pilihan Pick a category.  
 
 Pada daftar pilihan diatas, pilih dan klik satu kali Date, Time, Language, and Regional Options. Maka 

akan muncul kotak dialog lagi yang menampilkan dua pilihan icon baru yang dapat dipilih untuk mengatur 
konfigurasi komputer,  yaitu : 

 
a.  Date and Time    =  Digunakan untuk mengatur tanggal dan waktu 
 
b.  Regional and Language Options      

 
 =  Digunakan untuk mengatur tampilan angka,uang, dan lain-lain sesuai dengan daerah asal si 

pengguna (brainware) 
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5.2.f Membuang / Menghapus Program yang Terinstall di Komputer (Uninstall) 
 

Ada dua cara yang dapat dipilih untuk meng-uninstall (menghapus/meng-delete) suatu program yang 
terinstall di dalam komputer, yaitu melalui Menu All Programs atau Menu Control Panel yang ada pada Menu 
Start. 

 
A. Cara 1  :  Melalui Menu All Programs 

 Klik tombol Start                       , kemudian pilih All Programs 

 Pada daftar menu di All Programs, cari menu folder dari program yang ingin dihapus. 

 Apabila telah didapat, cari dan periksa di dalam folder tersebut pilihan icon yang bertuliskan « Uninstall ….  ». 
Pilihan icon ini berfungsi sebagai langkah singkat (shortcut) untuk menghapus program yang dimaksud dari 
dalam komputer.  

 Jika ada icon Uninstall … tersebut, pilih dan klik, maka komputer secara otomatis akan memproses untuk 
menghapus program tersebut dari komputer. 
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Contoh :  Menghapus program TuneUp Utilities 2006 dari komputer 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
B. Cara 2 :  Melalui Menu Control Panel 

 Klik tombol Start               ,      kemudian 

pilih Control Panel 

 Muncul daftar pilihan Pick a category. Pada 
daftar pilihan, pilih Add or Remove 
Programs.  

 Maka akan muncul kotak dialog yang berisi 
daftar nama-nama program yang ada / 
terinstall di dalam komputer, berikut besar 
kapasitas program.  

 Untuk menghapus program, pilih nama 
program dari daftar tersebut, kemudian 
tekan tombol Remove yang muncul di 
sebelah kanan bawah. 

 Program secara otomatis akan diproses 
untuk dihapus dari komputer  

 
 
 
 
 

 
 

5.2.g Mengatur / Mengontrol Volume Suara yang Dikeluarkan Komputer 

Ada 2 cara yang dapat dipilih, yaitu : 
a. Melalui menu : Start > Control Panel > Sounds, Speech, and Audio Devices > Sounds and Audio Devices 

> tab Volume > Advanced…  
b. Melalui menu : Start > All Programs > Accessories > Entertainment > Volume Control  
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Masing-masing cara diatas akan memunculkan kotak dialog pengaturan Volume Control seperti gambar 
dibawah. Lakukanlah pengaturan volume sesuai keinginan. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
5.2.h Menyusun Kembali / Men-defrag Isi Hardisk Komputer 

 
Secara normal, komputer menyimpan data pada hardisk secara kontinu. Akan tetapi, pada keadaan tertentu 

komputer menyimpan data tersebut secara terpecah-pecah. Dalam keadaan seperti ini, komputer akan 
membutuhkan waktu yang lebih lama untuk membaca data dari hardisk. Untuk menyatukan data yang terpecah-
pecah menjadi data yang kontinue, digunakanlah program Defragmentasi, yaitu Disk Defragmenter. 

 Langkah-langkah untuk mengoperasikan program Defragmentasi pada Windows adalah sbb : 
 

 Buka dan pilih menu :  
Start > All Programs > Accessories > System Tools > Disk Defragmenter  
 

 Maka akan muncul kotak dialog Disk Defragment 
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 Pilihlah drive hardisk yang ingin di-defrag (disusun) 

Ada 2 pilihan tombol utama yang dapat dipilih, yaitu : 
a. Tombol Analyze   Digunakan untuk melihat keadaan data pada hardisk yang dipilih tanpa men-

defragnya. 
b. Tombol Defragment   Digunakan untuk melihat keadaan data pada hardisk yang dipilih, sekaligus 

langsung men-defragnya. 
 Klik tombol Defragment untuk melakukan proses men-defrag data hardisk. 
 Tunggu beberapa menit selama proses berlangsung. Hasil akhir defrag akan ditampilkan pada kotak paling 

bawah dalam bentuk gambar berwarna.   
 

 
5.2.i Mematikan Program yang Membeku / Hang 

 
 Ketika anda bekerja dengan suatu program, tidak 
selamanya program tersebut bekerja dengan baik. 
Adakalanya pula program tersebut jadi tidak berfungsi 
dengan seharusnya sehingga tidak menerima perintah-
perintah dari sang pemakai. Dalam keadaan ini 
dikatakan program itu telah membeku atau biasa kita 
sebut dengan istilah : “Hang”. Pada umumnya tidak ada 
cara untuk memperbaiki program yang “Hang”, tetapi 
anda dapat mematikan program tersebut secara paksa.  
 Langkah-langkahnya adalah sbb : 

 Klik tombol : Ctrl + Alt + Del pada keyboard. 
 Apabila itu telah dilakukan, maka akan muncul 

kotak dialog Windows Task Manager.  
 Pada kotak putih di tab Applications akan 

ditampilkan semua program yang sedang aktif 
(jalan). Kolom Task berisi nama-nama program 
yang sedang bekerja (aktif), sedangkan pada 
kolom Status menunjukkan kondisi dari 
program tersebut, apakah sedang bekerja 
dengan baik (Running) atau tidak respon/hang 
(Not Responding). 

 Jika ditemukan ada program yang statusnya 
adalah “Not Responding”, berarti program 
tersebut tidak bekerja dengan baik atau lagi 
Hang. Untuk mematikan program tersebut, 
pilihlah program tersebut pada Kolom Task di 
tab Applications, kemudian tekan tombol “End 
Task” yang berada di bagian paling bawah 
kotak dialog. 

 Secara otomatis, program tersebut akan 
dimatikan secara paksa oleh komputer 
(Windows). 

 
 
 
5.2.j Memperbesar Ruang Kosong pada Hardisk 

Komputer 
 

 Ketika anda bekerja dengan menggunakan sebuah 
program pada Windows, terkadang program tersebut 
membuat file-file yang tidak diperlukan. Apabila anda 
telah bekerja untuk waktu yang lama, tentu saja jumlah 
file yang tidak diperlukan ini semakin banyak jumlahnya 
dan menghabiskan kapasitas dari hardisk anda. Untuk 
mengatasi hal ini, Windows menyediakan program 
“Clean Up” yang dapat menghilangkan file-file yang tidak 
diperlukan tersebut sehingga ruang kosong pada hardisk 
anda akan semakin besar. 
 
 



Teknologi Informasi dan Komunikasi ( TIK ) 

 23 

 Langkah-langkahnya adalah sbb : 
 Buka dan pilih menu :  

Start > All Programs > Accessories > 
System Tools > Disk Cleanup 

 Maka akan muncul kotak dialog Select 
Drive. Pilih drive pada hardisk yang akan 
dibersihkan pada kotak pilihan yang ada. 
Kemudian tekan tombol OK 

 Komputer akan melakukan proses scanning 
awal terhadap isi drive yang dipilih. Tunggu 
beberapa saat hingga muncul kotak dialog 
Disk Cleanup for [nama drive].  

 Pada kotak pilihan Files to delete di tab 
Disk Cleanup, beri tanda centang pada 
jenis-jenis file yang ingin dibersihkan / 
dihapus. Setelah itu tekan tombol OK. 

 Secara otomatis, komputer akan 
melakukan proses pembersihan (cleaning) 
terhadap file-file yang dipilih tersebut. 
Tunggu beberapa saat sampai proses 
selesai.  

 
 
 
 
 
 
 
 
 

MELAKUKAN MANAJEMEN FILE 
 
 Untuk melakukan manajemen file, kita dapat menggunakan program Windows Explorer. Windows Explorer 
adalah salah satu program aplikasi dalam Windows yang digunakan untuk mengelola file, folder, drive yang ada 
pada Local Drive (komputer yang sedang digunakan) dengan mudah dan cepat.  
 
6.1 Cara Membuka Windows Explorer 

 Cara-cara untuk membuka Windows Explorer adalah sebagai berikut : 

A.  Cara I :  Melalui Shortcut My Computer pada Layar Windows 

 Pilih dengan pointer mouse gambar icon/shortcut My Computer yang tampil di layar monitor, kemudian klik 
kiri mouse dua kali secara cepat atau tekan tombol Enter pada keyboard. 

 
 
 
 
 
B.  Cara II :  Melalui Menu All Programs 

 Buka dan pilih menu :  
Start > All Programs > Accessories > 
Windows Explorer  

 Pilih dan klik 2x icon Windows Explorer 
tersebut 

 
C.  Cara III :  Melalui Klik Kanan di Menu Start 

 Klik kanan mouse pada Menu Start di 
sebelah kiri bawah layar komputer hingga 
muncul kotak dialog pilihan 

 Pada kotak dialog tersebut, pilih dan klik 
pilihan ”Explorer” 

 

Icon MY COMPUTER 

VI 
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CONTOH TAMPILAN WINDOWS EXPLORER 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.2 Toolbar Windows Explorer  
 
 
 
 
 

Icon-icon diatas adalah bagian dari Toolbar Windows Explorer yang digunakan untuk menjelajah isi dari 
suatu drive / folder. Berikut keterangan dari masing-masing icon tersebut : 

 
 

ICON PERINTAH KETERANGAN 

 

Back To 
Kembali ke drive / folder sebelumnya yang pernah 
dibuka 

 

Forward To Maju ke drive / folder berikutnya yang pernah dibuat 

 

Up 
Naik satu level ke drive / folder sebelumnya atau level 
diatasnya 

 

Search Mencari file / folder yang dibutuhkan 

 

Folders 
Menampilkan atau menghilangkan tampilan sebelah kiri 
Windows Explorer 

Title Bar 

Menu Bar 

Toolbar 

Sizing Button 

Address 

Scroll Bar 

File/Data/ 
Dokumen 

Window Border  

Window 

Corner  
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Views 

Mengatur bentuk tampilan dari isi drive / folder atau file-
file yang sedang dibuka atau dijelajah.  

Ada beberapa pilihan tampilan : 

 Thumbnails 

= Untuk menampilkan file ataupun gambar dalam 
bentuk preview (gambar dalam bentuk kecil) 

 Tiles 

= Untuk menampilkan nama drive, folder, dan file 
dalam bentuk icon yang tersebar merata  

 Icons 

= Untuk menampilkan nama drive, folder, dan file 
dalam bentuk icon 

 List 

= Untuk menampilkan nama drive, folder, dan file 

 Details 

= Untuk menampilkan nama drive, folder, dan file 
lengkap dengan informasi mengenainya. 

 

 
 
 
6.3 Mengenal Tipe / Jenis File  
 

File-file yang terdapat pada Windows dapat dibedakan menurut bentuk ikon pada masing-masing file 
tersebut. Biasanya bentuk ikon disesuaikan dengan bentuk ikon program aplikasi yang digunakan. Selain itu, 
cara lain untuk mengetahui jenis file adalah menurut jenis extension –nya (nama keterangan file) yaitu tiga huruf 
yang berada di akhir nama file tersebut (setelah tanda titik). 

 

CONTOH MENURUT TIGA HURUF TERAKHIR  CONTOH MENURUT BENTUK IKON FILE 

JENIS FILE EXTENSION IKON TIPE FILE PROGRAM APLIKASI 

Gambar 
*.gif, *.bmp, *.tiff, 
*.jpg, dll 

 

.DOC Microsoft Word 

Teks *.doc, *.txt, dll 

 

.XLS Mircrosoft Excel 

Suara / Lagu 
*.wav, *.mp3, *.mid, 
*.ogg, dll 

 

.PDF Adobe Acrobat Reader 

Film 
*.dat, *.mov, *.mpg, 
dll 

 

.PPT Microsoft Power Point 

Program Inti /aplikasi 
(File yg digunakan untuk 
menjalankan sebuah 
program) 

*.exe 

 

.EXE Application 
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Yang tidak bisa dijalankan 
secara langsung (file 
pendukung untuk 
menjalankan program inti) 

*.dll, *.hdr, *.bin, dll 

 

.ZIP 
Winzip / Winrar  
(File Kompress) 

File tidak berguna  
(File yang sudah tidak 
diperlukan lagi oleh System 
Operasi Windows) 

*.$$$, *.???, *.-??, 
*.* 

 

.TXT Notepad 

File Sementara 
(File-file yang bersifat 
sementara dan apabila 
komputer direstart biasanya 
file2 tsb akan hilang) 

*.tmp 

 

.JPG Gambar tipe JPEG File 

 
 
Cara lain untuk mengetahui jenis / type file adalah 
dengan menampilkan file-file tersebut dalam 
bentuk Details, yaitu pada Toolbar Windows 
Explorer, pilih ikon Views lalu Details. 

 
Pada tampilannya nanti, dapat diketahui jenis atau 
tipe dari masing-masing file tersebut pada 
keterangan yang ada disebelah nama file, yaitu 
pada kolom Type. 
 
 
 
 
 
 
6.4 Membuat Folder Baru 
 
Langkah-langkah untuk membuat folder baru : 
 Pada jendela Windows Explorer, pilih 

drive/folder tempat dimana folder baru 
akan ditempatkan 

 Pilih dan klik menu File > New > Folder 
; atau dengan cara meng-klik kanan 
mouse di dalam jendela isi tampilan 
Windows Explorer hingga muncul kotak 
pilihan. Maka pilih dan klik New > 
Folder pada kotak pilihan tersebut.  

 
 
 
 
 
 
 
 
 
 
 Maka akan muncul folder baru yang masih kosong berjudul New Folder di 

dalam drive/folder yang dipilih tersebut.   
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6.5 Memberi atau Mengganti Nama File / Folder 
 
Langkah-langkah untuk membuat/memberi nama file/folder adalah sbb : 
 Pada jendela Windows Explorer, cari dan pilih file atau folder yang 

ingin diganti namanya 
 Pilih dan klik menu File > Rename ; atau dengan cara meng-klik 1x 

pada file/folder tersebut, kemudian klik kanan, dan pilih Rename 
pada kotak pilihan yang muncul; atau dengan cara menekan tombol 
F2 pada keyboard. 

 Nama file/folder tersebut dapat langsung diganti sesuai keinginan 
 Jika selesai, klik kiri mouse di sembarang tempat, atau tekan tombol 

Enter.  
 
 
 
 
 
 
 
6.6 Mengcopy / Menyalin File / Folder 
 
 Pada Jendela Windows Esplorer; cari, pilih, dan klik 1x file/folder yang diinginkan, kemudian klik kanan 

mouse dan pilih Copy pada kotak pilihan; atau dengan cara menekan tombol Ctrl+C pada keyboard. 
 Setelah itu, cari dan pilih drive/folder tempat dimana file/folder yang dicopy tersebut akan ditempatkan. 
 Klik kanan pada jendela isi Windows, lalu pilih Paste pada kotak pilihan; atau dengan cara menekan tombol 

Ctrl+V pada keyboard. 
 Hasil salinan/copian dari file/folder yang dipilih tersebut akan muncul di tempat yang baru sesuai keinginan. 

 
 
6.7 Memindahkan File / Folder 
 
 Pada Jendela Windows Esplorer; cari, pilih, dan klik 1x file/folder yang ingin dipindahkan, kemudian klik 

kanan mouse dan pilih Cut pada kotak pilihan; atau dengan cara menekan tombol Ctrl+X pada keyboard.  
 Setelah itu, cari dan pilih drive/folder tempat dimana file/folder yang ingin dipindahkan tersebut akan 

ditempatkan. 
 Klik kanan pada jendela isi Windows, lalu pilih Paste pada kotak pilihan; atau dengan cara menekan tombol 

Ctrl+V pada keyboard. 
 File/folder yang dipilih tersebut akan muncul di tempat yang baru (dipindahkan dari lokasi awal) sesuai 

keinginan. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tampilan Kotak Pilihan ketika meng-Klik Kanan Mouse pada File/Folder/Jendela Windows 

 
 
6.8 Menghapus File / Folder 
 
 Pada Jendela Windows Explorer, pilih dan klik 1x file/folder yang ingin dihapus, kemudian klik kanan dan 

pilih Delete; atau dengan cara menekan tombol Del/Delete pada keyboard. 
 
 
 

Perintah 

utk 

memindah 

kan file 

Perintah 

utk 

menyalin / 

mengcopy 

file 

Perintah utk 

menempatkan 

hasil salinan / 

pindahan file 

yang dipilih pada 

tempat yg baru 

Pilihan Rename setelah meng-klik kanan mouse pada file yang ingin 

diganti namanya 
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6.9 Mengelola File yang Sudah Dihapus Menggunakan Recycle Bin 
 
Setiap file/folder yang dihapus secara otomatis akan dipindahkan ke Recycle Bin (kotak sampah). Pada Recycle 
Bin, file/folder yang dihapus tersebut akan ditampung untuk suatu saat, dan apabila memang diperlukan lagi, bisa 
diambil/dikembalikan lagi ke tempat asal (Restore). 
Untuk melihat isi dari Recycle Bin, pilih dan klik icon/shortcut Recycle Bin pada layar Windows.    
 
 Untuk mengambil kembali atau mengembalikan lagi file/folder yang diperlukan ke tempat asal dari dalam 

Recycle Bin. Caranya : pilih dan klik kanan file/folder yang ingin dikembalikan tersebut, kemudian pilih 
Restore (maka secara otomatis file/folder tsb akan dikembalikan ke tempat semula) 

 
 Untuk betul-betul menghapus file/folder yang sudah tidak diinginkan lagi dari Recycle Bin. Caranya : pilih 

dan klik kanan file-file/folder2 tsb, kemudian pilih Delete (maka secara otomatis file/folder tsb akan benar-
benar terhapus dari Local Disk) 

 
 
 
 
 
 

CATATAN 

PENTING : 

 


